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Средство Axis Coverage Shapes для Microsoft® Visio® предоставляет интерактивные двухмерные модели камер
видеонаблюдения в формате CAD, которые можно использовать в Microsoft® Visio®. Модели камер можно поместить на план
этажа в программе Visio, чтобы создать наглядное представление охвата камер и интегрировать план системы охранного
видеонаблюдения в ваш проект.

В настоящем руководстве описана работа с программой Microsoft® Visio® Standard 2016. Пункты меню могут отличаться в
других версиях Visio.

На использование Axis Coverage Shapes для Microsoft® Visio® распространяются общие условия лицензирования программного
обеспечения Axis.

Начало работы

Скачивание файлов

В настоящем руководстве подразумевается, что вы уже знакомы с программой Microsoft® Visio®. Если вам нужна помощь
по использованию Visio, см. справку по Microsoft® Visio®.

1. Скачайте ZIP-архив Axis Coverage Shapes for Microsoft® Visio® на веб-странице axis.com/tools/axis-coverage-shapes

2. Извлеките файлы на локальный диск (C:) в папку Documents\My Shapes.

Добавление шаблонов области охвата в Visio

1. Откройте Microsoft® Visio®, а затем — область задач Shapes (Фигуры).

Если она не открывается или ее не видно, перейдите в раздел View (Вид) > Task Panes (Области задач) и выберите
Shapes (Фигуры).

2. В разделе Shapes (Фигуры) выберите More Shapes (Другие фигуры) > My Shapes (Мои фигуры), где можно
выбрать группу или группы загруженных шаблонов области охвата.

3. При появлении запроса выберите Trust all from publisher (Доверять всему от издателя) либо Enable Macros
(Включить макрос) в уведомлении о безопасности Microsoft® Visio®. Чтобы можно было использовать шаблоны
области охвата, необходимо активировать макросы.
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Теперь выбранные семейства камер будут доступны в области задач Shapes (Фигуры).

Импорт плана этажа
Проектирование системы в Microsoft® Visio® обычно начинается с импортирования плана этажа.

Прежде чем начать

Ознакомьтесь с советами по использованию наших инструментов для Инструменты измерения и Масштабирование.

Импорт чертежа CAD

Проверка масштаба файла AutoCAD

1. Чтобы проверить или изменить масштаб файла AutoCAD перед импортом файла, откройте диалоговое окно
Plot (Построение графика) в AutoCAD и запомните или измените масштаб. Дополнительные сведения см. в
соответствующих руководствах по AutoCAD.

Импорт рабочего файла AutoCAD

2. Чтобы импортировать файл AutoCAD, откройте Microsoft® Visio® и последовательно выберите Insert > CAD Drawing
(Вставить > Чертеж CAD). Выберите файл для импорта и нажмите Open (Открыть).

3. В диалоговом окне CAD Drawing Properties (Свойства чертежа CAD) задайте параметры CAD Drawing Scale
(Масштаба чертежа CAD) и проверьте, что установлены флажки Lock size and position (Заблокировать размер и
положение) и Lock against deletion (Заблокировать удаление).

При возникновении проблемы с импортом файла в Microsoft® Visio® попробуйте сохранить файл AutoCAD в
формате чертежа R14/LT98/LT97. Дополнительные сведения см. в соответствующих руководствах по AutoCAD.

Назначение слоя камеры изображению

4. Перед добавлением камер проверьте масштаб импортированного плана этажа. Чтобы проверить или изменить
заданный масштаб, перейдите в раздел Design > Page Setup > Drawing scale (Проектирование > Настройка
страницы > Масштаб чертежа).

5. Перейдите в раздел Home > Editing > Assign to Layer (Главная > Редактирование > Назначить слою) и создайте
новый слой, который будет выступать в качестве слоя для добавляемых камер. Перейдите в раздел Home >
Editing > Layers > Layer Properties (Главная > Редактирование > Слои > Свойства Слоя), выберите созданный
слой и отметьте его как Active layer (Активный слой).

Импорт файла PDF

Файлы PDF подходят для работы не идеально, так как это не векторные файлы. Для преобразования
файлов PDF в файлы изображений рекомендуется использовать онлайн-инструмент, такой как
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приложение для конвертации файлов формата PDF в файлы формата JPEG компании Microsoft либо
сделать моментальный снимок плана этажа в формате PDF, чтобы сохранить его как файл изображения.

Импорт рабочего изображения в формате PDF

1. Чтобы импортировать файл PDF, откройте Microsoft® Visio® и перейдите в раздел Insert > Object > Adobe Acrobat
Document (Вставить > Объект > Документ Adobe Acrobat).

2. Выберите файл для импорта и нажмите Open (Открыть).

После завершения импорта разместите импортированное изображение в формате PDF на одной странице в
Microsoft® Visio®.

Если требуется повернуть изображение, перейдите в раздел Home > Arrange > Position (Главная > Упорядочить
> Расположение).

3. Отметьте импортированный план этажа и перейдите в раздел Home > Arrange > Group (Главная > Упорядочить >
Группировать) и выберите пункт Ungroup (Разгруппировать).

Задайте масштаб изображения в формате PDF.

4. Чтобы задать масштаб изображения, используйте инструмент измерения.

5. После измерения откройте новую страницу в Microsoft® Visio® и перейдите в раздел Design > Page Setup > Drawing
scale (Проектирование > Настройка страницы > Масштаб чертежа), чтобы ввести значение масштаба.

Назначение слоя камеры изображению

6. Перейдите в раздел Home > Editing > Assign to Layer (Главная > Редактирование > Назначить слою) и создайте
новый слой, который будет служить базовым слоем для вашего плана этажа. Чтобы зафиксировать план на месте,
перейдите в раздел Home > Editing > Layers > Layer Properties (Главная > Редактирование > Слои > Свойства
слоя), выберите созданный слой и установите флажок Lock (Заблокировать).

Повторите этот шаг, чтобы создать еще один слой для добавляемых камер. В диалоговом окне Layer properties
(Свойства слоя) отметьте этот слой как Active layer (Активный слой).

Теперь можно приступить к добавлению камер на изображение плана этажа в формате PDF.

Импорт изображения карты

Вместо импорта изображения карты в Microsoft® Visio® рекомендуется использовать функцию Maps (Карты) в Site Designer.
Это удобный и надежный рабочий процесс, в котором используется встроенная функция работы с картами.

Добавление камер
Прежде чем начать

Компания Axis предоставляет регулярные обновления для этого продукта, поэтому работу с ним всегда следует начинать со
скачивания последней версии ПО на веб-странице axis.com/tools/axis-coverage-shapes.

1. После определения слоя для камер в плане этажа перейдите в раздел More Shapes > My Shapes (Другие фигуры
> Мои фигуры) и выберите необходимые семейства. Повторите этот шаг для всех семейств камер, которые
требуется загрузить в ваш проект.

2. Чтобы добавить модель камеры в план этажа, просмотрите выбранные семейства камер и перетащите их в модели
на чертеже.

3. Измените настройки моделей камер по умолчанию в плане этажа в соответствии со своим проектом.

- Чтобы изменить настройки области обзора модели камеры, используйте желтые переключатели внутри
модели. Значения в полях данных изменятся при изменении положения области обзора.
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- Чтобы изменить параметры модели камеры, щелкните правой кнопкой мыши по модели камеры и
выберите параметр Edit Shape Data (Изменить данные фигуры), с помощью которого можно настроить
большую часть атрибутов камеры.

- Чтобы изменить отображаемый текст для модели камеры, щелкните правой кнопкой мыши по модели
камеры и выберите пункт Edit Text (Изменить текст). Обновите имя модели камеры и нажмите кнопку
ESC на клавиатуре.

- Для копирования существующей модели камеры в другие места в том же плане этажа щелкните правой
кнопкой мыши по модели камеры и используйте команды Copy (Копировать) и Paste (Вставить).

4. Чтобы добавить расписание камеры для моделей камер в плане этажа, перетащите на чертеж шаблон Axis Product
Listing (Перечень продуктов Axis). Шаблон по умолчанию будет содержать уже размещенные модели в плане
этажа. Чтобы изменить отображаемый текст в списке, щелкните текстовое поле правой кнопкой мыши и выберите
команду Edit Text (Редактировать текст). После добавления изменений нажмите кнопку ESC на клавиатуре.

Экспорт в Site Designer
Чтобы можно было продолжить работу с проектным планом, нужно экспортировать весь план этажа и модели камер в AXIS
Site Designer.

1. Сохраните чертеж в Microsoft® Visio®.

2. Щелкните правой кнопкой мыши любую камеру на чертеже и выберите пункт Export all Cameras (Экспортировать
все камеры)

3. В диалоговом окне Export Cameras (Экспорт камер) выберите пункт Export to Axis Site Designer (Экспортировать
в Axis Site Designer). После завершения экспорта отобразится всплывающее диалоговое окно с расположением
экспортированного файла. Нажмите кнопку OK.

Примечание
В этом диалоговом окне можно также экспортировать проект в виде файла с разделителями-запятыми в другие
инструменты планирования (например, в Microsoft Excel). Перед нажатием кнопки Copy to Clipboard (Копировать в
буфер обмена) выберите пункт Comma (Запятые) в качестве разделителя.

4. Откройте Site Designer и выберите пункт Import project (Импортировать проект).

5. Перейдите к своему файлу в формате ASDP/ASDPX, который требуется импортировать, и нажмите кнопку Open
(Открыть). После завершения импорта вы получите уведомление в Site Designer.

Дополнительные сведения об AXIS Site Designer см. на веб-странице .

Всплывающие подсказки
В этом разделе представлено несколько полезных советов, которые помогут вам в работе с Microsoft® Visio®.
Для получения более подробных сведений и ознакомления с другими всплывающими подсказками см.
страницы поддержки по Microsoft® Visio®.

Создание шаблонов

В Microsoft® Visio® можно создавать шаблоны определенного размера бумаги, которые помогают быстро начать работу над
проектом. Используйте команду Save As (Сохранить как), чтобы вносимые изменения не применялись к исходному шаблону.

Создание дополнительных страниц в Visio

Чтобы добавить новую страницу в Microsoft® Visio®:

1. В области рисования перейдите в нижнюю часть страницы и щелкните значок креста, чтобы вставить страницу.
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2. Чтобы скопировать имеющийся чертеж в новую страницу, используйте клавиши Ctrl + A и Ctrl + C, чтобы копировать
чертежи и вставить их в новую страницу (клавиши Ctrl + V).

3. Чтобы переименовать страницу, щелкните правой кнопкой мыши по новой странице и выберите Rename
(Переименовать).

Инструменты измерения

Чтобы работать с масштабом в проектах, используйте инструменты измерения Microsoft® Visio®.

1. Чтобы добавить инструменты измерения на панель инструментов Shapes (Фигуры), перейдите на панель
инструментов Shapes (Фигуры) и выберите More Shapes (Другие фигуры) > Visio Extras (Дополнительные
инструменты Visio) > Drawing Tool Shapes (Фигуры инструмента рисования)

Выберите пункт Horizonal measure (Измерение по горизонтали) и Vertical measure (Измерение по вертикали) из
доступных инструментов.

2. Чтобы добавить инструменты измерения в раздел Favorites (Избранное), щелкните правой кнопкой мыши пункт
Horizonal measure (Измерение по горизонтали) и (или) Vertical measure (Измерение по вертикали) на панели
инструментов Shapes (Фигуры) и выберите Add to My Shapes (Добавить к моим фигурам) > Favorites (Избранное).

Масштабирование

Если создаваемые чертежи содержат объекты из реального мира, превышающие размер печатной страницы, их необходимо
начертить в соответствующем масштабе. Масштаб чертежа рекомендуется определять перед импортом плана этажа.

1. Перейдите в раздел File (Файл) > New (Создать) и создайте новый проект.

2. На вкладке Design (Проектирование) перейдите в раздел Page Setup (Настройка страницы) (клавиши Shift + F5),
чтобы открыть весь набор параметров форматирования страницы.
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3. В разделе Page Setup (Настройка страницы) перейдите к пункту Drawing Scale (Масштаб чертежа) и введите
предварительно заданное значение масштаба и (или) размера страницы

Дополнительные сведения о настройке масштаба см. в онлайн-справке по Microsoft® Visio®.
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Ответы на типичные вопросы

Почему при добавлении продукта на чертеж Visio® происходит изменение масштаба
чертежа?
При размещении камеры в проекте ®Visio у вас не должно возникать никаких проблем. Если возникла такая проблема,
отправьте нам отчет об ошибке, используя этот шаблон письма. Не забудьте указать все необходимые сведения о вашей
проблеме (продукты, с которыми возникла проблема, снимки экрана). Письмо должно быть на английском языке.

Переключатель для перетаскивания с целью изменения фокусного расстояния
не работает на всех камерах. Почему?
Все камеры оснащены переключателем Drag to change the Focal Length (Перетащите для изменения фокусного расстояния),
даже если на некоторых камерах это значение изменить нельзя.

В некоторых камерах это значение на переключателе фиксированное (а не диапазон между несколькими переменными),
поэтому при наличии фиксированного значения переключатели не могут выполнять другую функцию (поскольку ничего
нельзя отрегулировать в имеющемся диапазоне).

Почему нельзя сохранить чертеж Visio® в формате PDF, если на чертеже есть
многоматричные камеры?
Это известная ошибка, относящаяся к функциям Microsoft® Visio®. Попробуйте сохранить файл в формате PDF с помощью
функции Print to PDF (Печать в PDF). Перейдите в раздел File > Print > Printer (Файл > Печать > Принтер). Выберите пункт
Microsoft® Print to PDF и нажмите кнопку Print (Печать). После нажатия кнопки Print (Печать) можно выбрать место
печати (то есть сохранения) файла PDF.

Почему при добавлении камеры на чертеж Visio® камера направлена сверху вниз?
При размещении камеры в проекте ®Visio у вас не должно возникать никаких проблем. Если возникла такая проблема,
отправьте нам отчет об ошибке, используя этот шаблон письма. Не забудьте указать все необходимые сведения о вашей
проблеме (продукты, с которыми возникла проблема, снимки экрана). Письмо должно быть на английском языке.
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Поддержка

Поддержка

Если вам необходима поддержка по использованию и функционалу Microsoft® Visio®, см. страницы поддержкиMicrosoft® Visio®.

Если вам необходима поддержка по использованию и функционалу Axis Coverage Shapes, рекомендуем ознакомиться с нашим
онлайн-руководством и статьями из раздела «Вопросы и ответы» перед отправкой сообщения о проблеме.

Если проблема сохраняется, используйте этот шаблон письма, чтобы сообщить о своей проблеме компании Axis. Не забудьте
указать все необходимые сведения о вашей проблеме, в том числе информацию о моделях устройств, в которых возникла
проблема. Письмо должно быть на английском языке.

Примечание
мы оказываем поддержку исключительно по работоспособности функций предоставляемого нами инструмента САПР.
Мы не оказываем поддержку по вопросам и проблемам, которые не связаны с продуктами компании Axis.
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Please fill in all questions below and attach, if needed, any screenshot of your issue to allow Axis to help you in an efficient way. Note that we provide support only on the functionality that affects the Axis plugin and its features.



	Please state which operating system you are using: Windows 7/Windows 10/Other: (Please specify)



	Did you do any changes to the system (system or software updates) before the problem occurred? Yes / No



	If yes, which system or software you changed?



	Which version of Visio do you use?



	Which version of the coverage shapes do you use?



	Are you using Metric or Imperial measures?



	Which product family you were using when the problem occurred?



	Please describe the problem you are experiencing.



Best Regards,

[your signature and contact details]


Руководство по эксплуатации Версия M1.3
Axis Coverage Shapes for Microsoft® Visio® Дата: Апрель 2021
© Axis Communications AB, 2021 № компонента T10163966
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